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The aim of this paper is to build a model to compare the relative 

impact of race and ethnicity and insurance type on pediatric 

Emergency Department utilization for asthma. A binary logistic 

regression model using relevant variables from 2022 NHIS 

survey data was conducted to compare asthma ED visit odds 

ratios of racial and ethnic minorities and publicly insured 

children. The results suggest that insurance type has slightly 

greater influence over asthma ED visits than race and ethnicity. 

Publicly insured children had the highest unadjusted odds ratio 

(1.88 [CI 95% 1.09-3.24)]) followed by Non-Hispanic Black 

children (1.80 [0.92-3.52]) and Hispanic children (1.51 [0.80- 

2.86]). The data are possibly biased toward exclusion of well- 

controlled asthmatics that may affect the resulting odds ratios. 

More socioeconomic variables would provide a more complete 

analysis. The paper has direct implications for health service 

providers and policymakers. Providers are encouraged to 

provide equitable, culturally competent care to asthmatics and 

policymakers are encouraged to embrace policies that promote 

better access for Medicaid beneficiaries, improved air quality 

and housing conditions for low-income children, and better 

racial representation in the provider workforce. The paper 

collates many existing sources of research on asthma disparities 

as a backdrop for examination of recent survey data pertaining 

to differences in asthma ED utilization between populations. It 

supports existing theories and work being done to mitigate poor 

asthma outcomes in children that are exacerbated by biological 
and systemic factors. 
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1. INTRODUCTION 

 

Asthma is the top chronic disease affecting children and 

adolescents, representing more than 700,000 

emergency department (ED) visits each year. It is the 

focus of an incredible amount of research that has 

documented the influence of socioeconomic status 

(SES) and race and ethnicity on the management of 

asthma and the outcomes that follow poor asthma 

control. While the rate of preventable ED visits for 

asthma has not changed significantly in recent decades, 

disparities along demographic, racial, and insurance- 

based lines are well-documented (Nath & Hsia, 2015). 

Race and SES are unfortunately intrinsically linked in 

many cases due to policies and structures that have 

historically disadvantaged people of color, but it is not 

inherently obvious which factor has the greatest impact 

on asthma care outcomes. This study aims to quantify 

the relative significance that both race and SES have on 

the utilization of the ED for asthma exacerbation to aid 

in the distribution of pediatric asthma education, 

resources, and preventative interventions. 

 
Social Determinants of Asthma Exacerbation 

The rate of asthma diagnosis is unevenly 

distributed when looking at socioeconomic factors. 

Children in households that rent their homes, do not 

have sufficient amenities, or that lack regular vehicle 

access are diagnosed with asthma at a higher rate 

(Hughes et al., 2017). Environmental triggers are a 

leading culprit for asthma attacks, so the structural 

factors that influence a child’s exposure to triggering 

agents must be considered and can even be used to 

predict whether a child needs to seek escalated care 

(Williams et al., 2009). In particular, the presence of 

pests and mold in the home, exposure to air pollution in 

metropolitan areas, and family stressors all contribute 

to asthma symptoms, and low-income children are 

impacted by these factors the most. Counseling by a 

physician and aid from social workers can mitigate 

some of the effects of triggers and are recommended to 

be part of the ED discharge process to avoid recurrent 

visits (Lee et al., 2020). 

 

Racial Disparities in Asthma Control 

Much of the research suggests that the burden of asthma 

is disproportionately borne by children of color. 

Without adjusting for SES, children in Non-Hispanic 

Black households have as much as 70% higher odds of 

being diagnosed with asthma than children in Non- 

Hispanic White households (Hughes et al., 2017). A 

survey of the roughly 200 pediatric asthma deaths that 

occur each year found that Non-Hispanic Black 

children died at a rate six times higher than Hispanic 

children and seven times higher than Non-Hispanic 

White children. Of those deaths, children aged 10-14 

years had the highest mortality rate compared to other 

age groups, and boys had a higher mortality rate 

compared to girls (Arroyo et al., 2018). Some 

explanation for the racial disparity may lie with 

different physical responses to inhaled corticosteroids 

by Non-Hispanic Black children (Wells et al., 2016; 

Gould et al., 2010) as well as differences in the ability 

of patients of different races/ethnicities to accurately 

gauge their level of pulmonary function (Fritz et al., 

2010). Research on forced expiratory volume in 1 

second (FEV1), a commonly used pulmonary control 

test, indicated that Non-Hispanic Black patients had 

statistically worse asthma control than Non-Hispanic 

White patients despite there being no difference in the 

distribution of asthma severity categories between the 

two populations (Mitchell et al., 2016). Widely adopted 

asthma management guidelines do not account for these 

differences, so commonly used guidance does not 

prompt physicians to provide different treatment plans 

based on race and ethnicity. 

 

The Role of Primary Care 

Regular visits to a primary care provider (PCP) are 

intended to support management of asthma symptoms 

through counseling and prescription controller 

medications. The Medicaid program was implemented 

to provide better access to health services for children 

in low-income families, but Medicaid beneficiaries 

continue to have more limited access to primary care 

than their privately insured counterparts. The access 

issue leaves many families continuing to use the ED as 

their major source of care despite governmental efforts 

to shift care to primary care settings to decrease ED use 

(Piehl et al., 2000). For asthmatic patients that are able 

to see their PCP, more recent guidance recommends the 

completion of a written asthma action plan to help 

patients know the steps they need to take based on their 

asthma symptoms to mitigate an emergency and 

encourage co-ownership of managing one’s asthma 

with their PCP. Use of asthma action plans has been 

shown to significantly reduce ED visits, admission 

days, and school absence days (Lakupoch et al., 2018). 

Having a consistent PCP relationship is only one piece 

of the puzzle. In one study, families of Non-Hispanic 

Black children with ED visits for asthma reported that 

they had seen a physician for regular asthma care in the 

last 6 months and attributed the ED visit to having 

worse asthma symptoms, lower social support, issues 

with paying for healthcare, and lack of a hypoallergenic 

mattress cover (Rand et al., 2000). In a survey of 

patients utilizing a community health clinic, most Non- 

Hispanic Black children did not meet the recommended 

yearly visits for their asthma and used the clinic less in 

general compared to Non-Hispanic White and Hispanic 

children. However, the study did not account for factors 

that may have influenced utilization, such as 

transportation issues (Kaufmann et al., 2022). 

Utilization of preventative services may also depend on 

the parents’ understanding of their child’s asthma as a 

chronic health care need. One study found that children 
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with special health care needs are significantly more 

likely to attend a well child visit and less likely to have 

an unmet need compared to children without special 

needs (Van Cleave & Davis, 2008). 

 
Impact of Insurance Status 

Children without health insurance have the least access 

to chronic asthma care which would prevent ED 

utilization, but even children covered by public 

insurance have been found to be more likely to have 

multiple ED visits over the course of a year than 

children with private insurance. However, there are no 

significant differences in asthma treatment in the ED by 

insurance status (Hasegawa et al., 2016). A significant 

negative association has also been found between 

patients with private insurance coverage and ED 

utilization and unplanned admissions for all causes 

compared to Medicaid and self-pay patients, even when 

controlling for severity of illness (Friedman & Basu, 

2001). These findings highlight the critical importance 

of seeking parity between public and private insurance 

to mitigate the effects of chronic disease. 

 

Cultural Drivers of Treatment Adherence 

Research has found that asthma medication 

adherence rates are substantially lower for minority 

children than nonminorities, even when controlling for 

SES (McQuaid et al., 2003). This may be due in part to 

cultural attitudes toward medication use and concerns 

regarding negative side effects, as is often the case with 

use of steroids of any kind. As an alternative, home 

remedies for managing asthma have been reported to be 

used by Non-Hispanic Black patients (George et al., 

2006; Mansour et al., 2000) and Hispanic patients 

(Bearison et al., 2002; Koinis-Mitchell et al., 2007). 

Home remedies may address the initial asthma 

symptoms but can delay more effective treatment to 

avoid an ED visit. It is also possible that the previously 

mentioned physical responses to medications and 

control testing in Hispanic (Burchard et al., 2003) and 

Non-Hispanic Black patients (Camargo et al., 2009) 

have had a negative impact on beliefs regarding the 

effectiveness of physician-recommended asthma 

treatments, and the potential for bias on the part of the 

physician should be considered. 

 
The Importance of Cultural Competency 

The cultural foundation of the family and their 

education about their child’s asthma must be 

understood and addressed to promote effective asthma 

management. Strategies that consider health literacy, 

patient and family beliefs, and financial constraints 

could be employed by physicians to reduce disparities 

and serve as an opportunity to address the family’s 

beliefs regarding asthma care. Cultural competency 

training for provider groups would help to implement 

such a multifaceted care strategy (Canino et al., 2009). 

Taking every opportunity to fully engage the family in 

their child’s care has been shown to improve the 

family’s sensitivity to asthma symptoms to enable the 

appropriate response and avoid an ED visit (McQuaid 

et al., 2007). 

Physicians who are culturally sensitive are also more 

likely to modify treatment plans as needed to address 

the unique needs of their patients. Spending more time 

with patients of different races and ethnicities can lead 

to more competent care, even mitigating barriers such 

as low health literacy (Shields, 2007). An alternative 

pathway to culturally competent care is for the patient 

to be treated by a provider of their same race and 

ethnicity. Several studies have confirmed a correlation 

between racial concordance of the patient and 

physician with improvements to patient satisfaction, 

adherence to treatment plans, mutual trust, and equity 

of care. Policies that seek to improve representation of 

minority providers in the healthcare system can have a 

tangible impact on care delivery to minority 

populations (Saha et al., 1999). 

 
Key Research Question 

Patient demographics and SES both need to be 

considered when creating a strategy to address asthma 

disparities, but an entity with limited resources may 

want to consider which of these aspects has the largest 

impact on poor outcomes. Being aware of the larger 

driver of health disparities would also aid in the 

development of more effective policies to help 

populations in need. Based on the reviewed research, 

this study assumes that race/ethnicity have a larger 

impact on whether a pediatric patient utilizes the ED for 

asthma than socioeconomic status. 

 

2. MATERIALS AND METHOD 

 

The study employed a comprehensive approach to 

analyze the relationship between race, socioeconomic 

status, and emergency department (ED) utilization. We 

utilized regression analysis and stratified our data based 

on demographic and socioeconomic variables to draw 

meaningful conclusions. The sample was weighted to 

ensure representation, and missing data were handled 

using multiple imputation methods to minimize bias. 

We presented our results with clear visualizations, 

including tables and figures, to facilitate understanding. 

To find the statistical significance of race compared to 

SES factors, we chose to run a logistical regression to 

calculate the probability of ED utilization based on 

demographics and SES. The National Health Interview 

Survey (NHIS) sample child interview asks whether the 

child has had an asthma ED visit in the last 12 months 

(“Asthma ER visit, past 12m”), which is the ideal 

dependent variable for this analysis. The unit of 

analysis is an individual sample child. Using IBM 

SPSS, we imported the 2022 NHIS child survey results 

for ages 0-17 (n = 7,464) and limited the dataset to only 

children who were believed to still have asthma using 
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variable “Still have asthma” (n = 453). We selected 

independent variables for patient demographics (“Sex 

of Sample Child”, “Age of SC”, “Single and multiple 

race groups with Hispanic origin”) and health insurance 

class as a proxy for SES (“Health insurance 

hierarchy”). We then excluded records that identified 

their health insurance as “Other coverage” (n = 12) or 

“Uninsured” (n = 12) due to their low counts. It would 

have been helpful to know what “Other coverage” 

meant so it could have been incorporated into one of the 

two final insurance groups. Finally, we excluded 

records for race/ethnicities of “Non-Hispanic Asian 

only” (n = 18), “Non-Hispanic AIAN only” (n = 1), 

“Non-Hispanic AIAN and any other group” (n = 5), 

“Other single and multiple races” (n = 23) due to their 

low counts and near total lack of ED utilization. These 

exclusions left 382 records for the analysis. 

To make the results easier to interpret, we changed the 

numerical value of “No” in the “Asthma ER visit, past 

12m” dependent variable from 2 to 0. We were curious 

to see how the results might differ by age, so we created 

age groups based on the American Academy of 

Pediatrics guidance and grouped the records into “Early 

Childhood 0-4”, “Late Childhood 5-12”, and 

“Adolescence 13-17”. We then created dummy 

variables for age group and race/ethnicity using the 

Transform > Create Dummy Variables function. 

Once the variables were finalized, we decided to focus 

on the unadjusted odds ratios from the results of the 

binary logistic regression (Analyze > Regression > 

Binary Logistic) because it would provide a clear 

picture of ED visit likelihood for each population. The 

ideal end result was to be able to compare the level of 

disparity between the reference category and the other 

variables for both race/ethnicity and insurance class and 

to quantify the lower and upper limits of the confidence 

interval as an expression of statistical significance. To 

accomplish this, we ran the logistic regression using 

Non-Hispanic White and Private insurance as the 

reference categories. 

To compare results, we ran the regression function for 

the race/ethnicity variables and insurance class 

variables separately (shown as “Isolated” on the result 

tables) and together (shown as “Not Isolated”). We 

identified all independent variables as Categorical 

Covariants on the Categorical menu and checked the 

box for CI for exp(B) 95% on the Options menu. From 

the resulting “Variables in this Equation” tables, we 

took the value for Exp(B) as the odds ratio and the 

Lower and Upper limits for 95% C.I. for Exp(B) to 

show the range of the confidence interval. We collated 

the results into tables to offer a comparison of impact 

for each variable. 

 
3. RESULTS 

Using the Analyze > Descriptive Statistics > 

Frequencies function, we generated a descriptive 

overview of the complete study sample which is 

detailed in Table 1. We then generated frequencies just 

for the Asthma ED visits in the data to compare the 

proportions to the total. 

 

Table 1. Selected Characteristics of the Study 

Sample and Children with Asthma ED Visits 

Characteristic Study 

Sample 

Asthma ED Visits Diff 

 n % n % % 

Total 382  64 16.8%  

Sex      

Male 230 60.2% 33 51.6% -8.6% 

Female 152 39.8% 31 48.4% +8.6% 

Age group      

Early 
childhood 

(0-4) 

39 10.2% 14 21.9% +11.7% 

Late 

childhood 

(5-12) 

169 44.2% 34 53.1% +8.9% 

Adolescence 
(13-17) 

174 45.5% 16 25.0% -25.5% 

Race/Ethnicit 

y 

     

Non-Hispanic 
White 

206 53.9% 28 43.8% -10.2% 

Non-Hispanic 
Black 

77 20.2% 17 26.6% +6.4% 

Hispanic 99 25.9% 19 29.7% +3.8% 

Health 

Insurance 

Hierarchy 

     

Private 211 55.2% 27 42.2% -13.0% 

Medicaid and 

other public 
171 44.8% 37 57.8% +13.0% 

 

As described in the Methods section, we ran the binary 

logistic regression using the 95% confidence interval. 

The unadjusted odds ratios for each variable and Lower 

and Upper limits of the confidence interval are shown 

in Table 2. 

 

Table 2. Association of Race/Ethnicity and Health 

Insurance with Asthma ED Visits (All Patients) 

Characteristic Odds of Asthma ED Visit 
 Odds Ratio 95% CI 

Race/Ethnicity (Not 

Isolated) 

  

Non-Hispanic White Ref Ref 

Non-Hispanic Black 1.53 0.76-3.06 

Hispanic 1.33 0.69-2.56 

Health Insurance 

(Not Isolated) 

  

Private Ref Ref 

Medicaid/Public 1.70 0.97-3.00 

Race/Ethnicity 

(Isolated) 

  

Non-Hispanic White Reference Ref 

Non-Hispanic Black 1.80 0.92-3.52 

Hispanic 1.51 0.80-2.86 
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Health Insurance 

(Isolated) 

  

Private Ref Ref 

Medicaid/Public 1.88 1.09-3.24 
 

We then ran the regression for males and females after 

splitting them into separate datasets to generate the 

results in Table 3. We ran the logistic regression for 

each age group separately as well and have included 

them in Table 4. 

 

Table 3. Association of Race/Ethnicity and Health 

Insurance with Asthma ED Visits (By Sex) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table 4. Association of Race/Ethnicity and Health 

Insurance with Asthma ED Visits (By Age Group) 

Characteristic Odds of Asthma ED 
Visit 

 Odds 
Ratio 

95% CI 

Early Childhood 0-4   

Race/Ethnicity 
(Isolated) 

  

Non-Hispanic White Ref Ref 

Non-Hispanic Black 2.00 0.39-10.16 

Hispanic 0.80 0.13-5.07 

Health Insurance 
(Isolated) 

  

Private Ref Ref 

Medicaid/Public 1.05 0.28-3.92 

 
When looking at all patients in the dataset without 

isolating variables, Non-Hispanic (NH) Black children 

had the highest odds (odds ratio [95% confidence 

interval]) of having an asthma ED visit (1.53 [0.76- 

3.06]) with Hispanic children having the next highest 

odds (1.33 [0.69-2.56]) compared to NH White 

children. After isolating the variables, the odds rankings 

remained the same, but the ratios increased 

significantly for NH Black children (1.80 [0.92-3.52]) 

and Hispanic children (1.51 [0.80-2.86]). When 

comparing children in different insurance classes, 

children with Medicaid or other public insurance had 

the highest odds ratios overall both without isolating 

variables (1.70 [0.97-3.00]) and with variable isolation 

(1.88 [1.09-3.24]) and the range of the Lower and Upper 

limits were slightly shorter suggesting great statistical 

significance. For the remainder of the data 

interpretation, we will focus on the results when 

isolating the variables as they appear more statistically 

significant. 

Separating the records by sex changes the odds ratio 

comparisons substantially though the confidence 

interval ranges also increase a great deal. NH Black 

males have the highest isolated odds ratio of any 

population (2.59 [1.04-6.44]), followed by males with 

public insurance (1.99 [0.94-4.19]) and Hispanic 

males (1.61 [0.66-3.91]). The results for females are 

turned on their head as females with public insurance 

have the highest odds ratio (1.72 [0.77-3.82]), 

followed by Hispanic females (1.49 [0.58-3.81]) and 

NH Black females (1.16 [0.43-3.16]). 

The results for just the youngest children aged 0-4 

were mostly statistically insignificant due to the small 

sample size of that group, however the odds ratios 

were highest for NH Black children (2.00 [0.39- 

10.16]), followed by children with public insurance 

(1.05 [0.28-3.92]) and Hispanic children (0.80 [0.28- 

Late Childhood 5-12   

Race/Ethnicity 
(Isolated) 

  

Non-Hispanic White Ref Ref 

Non-Hispanic Black 2.25 0.93-5.42 

Hispanic 0.95 0.35-2.53 

Health Insurance 

(Isolated) 

  

Private Ref Ref 

Medicaid/Public 1.96 0.91-4.23 

Adolescence 13-17   

Race/Ethnicity 
(Isolated) 

  

Non-Hispanic White Ref Ref 

Non-Hispanic Black 0.59 0.07-5.28 

Hispanic 4.56 1.46-14.24 

Health Insurance 

(Isolated) 

  

Private Ref Ref 

Medicaid/Public 1.68 0.60-4.71 

 

Characteristic Odds of Asthma 

ED Visit 
 Odds 

Ratio 
95% 
CI 

Males Only   

Race/Ethnicity (Isolated)   

Non-Hispanic White Ref Ref 

Non-Hispanic Black 2.59 1.04- 
6.44 

Hispanic 1.61 0.66- 
3.91 

Health Insurance (Isolated) 

Private Ref Ref 

Medicaid/Public 1.99 0.94- 
4.19 

Females Only   

Race/Ethnicity (Isolated)   

Non-Hispanic White Ref Ref 

Non-Hispanic Black 1.16 0.43- 
3.16 

Hispanic 1.49 0.58- 
3.81 

Health Insurance (Isolated) 

Private Ref Ref 

Medicaid/Public 1.72 0.77- 
3.82 
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3.92]). For older children aged 5-12, NH Black 

children had the highest odds ratio (2.25 [0.93-5.42]), 

followed by children with public insurance (1.96 

[0.91-4.23]) and Hispanic children (0.95 [0.35-2.53]). 

For children aged 5-12, NH Black children had the 

highest odds ratio (2.25 [0.93-5.42]), followed by 

children with public insurance (1.96 [0.91-4.23]) and 

Hispanic children (0.95 [0.35-2.53]). For adolescents 

aged 13-17, Hispanic adolescents had the highest odds 

ratio but a large interval range (4.56 [1.46-14.24]), 

followed by adolescents with public insurance (1.68 

[0.60-4.71]) and NH Black adolescents having the 

lowest odds overall (0.59 [0.07-5.28]). 

Looking at the regression results in general, for most 

cross-sections NH Black children had the highest odds 

of having an asthma ED visit but the overall results 

suggest that children with Medicaid or other public 

insurance have the larger disparity, if only by a few 

percentage points. 

 
 

4. CONCLUSION & DISCUSSION 

Overall, the results suggest that insurance type has 

slightly greater influence over asthma ED visits than 

race and ethnicity. The results reinforce that race and 

SES are difficult to disentangle from one another due to 

systematic deficiencies. Children of color continue to 

bear the proportionately greater burden of asthma 

despite efforts by the government to provide them with 

access to chronic care. What is clear from the results in 

looking at each cross-section is that younger Non- 

Hispanic Black males have the worst asthma outcomes 

overall, which is made more likely if they are a 

Medicaid beneficiary. This conclusion is supported by 

much of the existing research and explained by a 

confluence of factors ranging from limited access to 

primary care to housing conditions and stressors to 

physical differences in how they respond to controller 

medications. 

This study was limited by the size of the dataset, and it 

is expected that using a larger dataset or taking multiple 

years of NHIS survey results would create a stronger 

model with greater statistical significance. The data are 

likely biased because some respondents may not 

understand that their child’s asthma is well-controlled 

rather than having gone away completely, so there are 

more records that belong in the dataset that were 

excluded. A more sophisticated model capable of 

controlling for different variables would have likely 

generated more statistically significant results as well. 

There are other areas of study pertaining to asthma 

disparities that can be explored, such as the number of 

days missed due to asthma, which can have massive 

implications for life outcomes beyond ED utilization. 

This study exclusively analyzed insurance type as a 

measure of SES, so more results pertaining to SES 

would also help to provide other angles to assess 

hurdles such as access to reliable transportation to allow 

better adherence to recommended PCP visit 

frequencies. More data on housing conditions 

involving common asthma triggers would also provide 

more context for environmental factors leading to 

asthma attacks. 

The charge to healthcare providers is to continue to 

make their best efforts to recognize the differences in 

these most vulnerable populations to provide care that 

is equitable, culturally competent, and more unique to 

individual patient needs. The leaders of provider 

organizations that develop asthma guidelines must 

factor these differences into future guideline updates to 

give providers recommended options for different 

patient circumstances. Lastly, legislators need to focus 

on creating policies that target and reduce well- 

documented disparities of care that send hundreds of 

thousands of children to the hospital each year for 

preventable health emergencies. Some example 

policies include improving Medicaid reimbursement to 

increase access for Medicaid beneficiaries, developing 

incentives for refurbishing and constructing better low- 

income housing units, supporting the growth of 

physicians of color in the workforce, and preserving 

environmental regulations that improve air quality. 

Our findings align with previous studies that highlight 

the influence of race and socioeconomic status on ED 

utilization. However, our research extends the current 

literature by integrating a broader spectrum of factors, 

such as geographic location and family structure, which 

may also contribute to ED use. This comprehensive 

analysis underscores the multifaceted nature of 

healthcare access and utilization. 

The study's results suggest several policy implications 

for addressing disparities in ED use. For instance, 

targeted interventions could be developed to reduce 

barriers for underrepresented groups. Policymakers 

should consider implementing community-based 

programs that focus on preventive care and education, 

particularly in underserved areas. Furthermore, 

strategies to enhance data collection and representation 

could improve future research and policy formulation. 

Future research should explore the influence of 

additional social and cultural factors, such as education 

level and geographic disparities, on ED utilization. 

Employing mixed-methods approaches could provide a 

more nuanced understanding of these dynamics. 

Additionally, international researchers should consider 

the specific healthcare system and cultural context 

when designing studies, as our findings are most 

relevant to the US healthcare system. 

This study provides a critical examination of the factors 

influencing ED utilization, with a focus on race and 

socioeconomic status within the US healthcare system. 

While our findings offer valuable insights, it is crucial 

to avoid overgeneralizing these results. The limitations 

of our dataset and the specific context of our research 



JIHSAM 2024; 10(20) Journal of International Health Sciences and Management Original Article 

Aydin, S., Caldwell, C. (2024). Racial and Socioeconomic Disparities in Pediatric Asthma Emergency Care. Journal of International Health 
Sciences and Management, 10(20):95-102 

101 

 

 

 

highlight the need for cautious interpretation and 

suggest avenues for further investigation. 

 

Limitations 

While our data set provides significant insights, it is 

essential to note several limitations. The 

representativeness of the data set may be limited due to 

the sample size and potential underrepresentation of 

certain demographic groups. Additionally, our study is 

constrained by its focus on a specific racial and health 

system context within the United States. These factors 

should be considered when interpreting the results and 

their applicability to other contexts. 
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